Chapter 5: Searching an Online Database

With the EndNote Online Search command, you can search online
bibliographic databases just as easily as you can search an
EndNote library on your own computer. And to make it even
easier, the results of your searches are saved as references in
your own EndNote library.

This section will guide you through these basic steps:
¢ Connect to an online database.

¢ Search the database and download the references into an
EndNote library.

NOTE: In order to follow this exercise, you must be at a computer with
access to the Internet (either dial-up or a direct network connection).

About the PubMed Database

For this lesson, you will connect to PubMed, the National Library
of Medicine’s online public access version of their MEDLINE
database. PubMed is the online database you will be searching;
the National Library of Medicine is the information provider.

For Users With “Dial-up” Internet Connections

If you use a modem and a phone line to connect to the Internet,
as opposed to a direct network connection, this section pertains
to you.

Connecting: Most setups for dial-up connections are configured
to automatically dial your information provider and connect to
the Internet when you use an application that requests an online
connection (as EndNote’s Online Search command does).
However, some setups require that you establish an online
connection (sign on) before choosing EndNote’s Online Search
command.

Disconnecting: EndNote disconnects from an online database as
soon as a search is completed, but will not disconnect your
Internet connection at any point. You need to shut down your
connection when you have finished using EndNote’s Online
Search feature.

Open the If EndNote is not already running, start it and open the sample

Sample library (Sample_Library.enl), as shown under “Start EndNote” on
. page 25.

Library
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Connect to an
Online
Database 1.

The first step in searching an online database is connecting to it.

To connect to the PubMed Database:
Go to the Tools menu and select Online Search to see the

available list of online databases. You could also look under
Online Search in the Groups pane and click more.

(The Groups pane will remember databases you have

connected to in the past for easy access under Online Search.
You can also customize a list of favorite databases to search
by using the Connection Manager.)

Click to
show more
or less info
about the
selected
connection
file.

=

=

Choose A Connection g|
Mame Information Provider L
PsycARTICLES (OCLC) ocLe
PsycBOOKS (OCLC) ocLe
PsycCRITIQUES (OCLC) ocLe
PsycFIRST (OCLC) ocLe
PeycINFO (C5A) CsA
PsycINFO (EBSCO) EBSCO
PsycINFO (DCLC) ocLe
PsycINFO (OvidsP) OvidsP
PsycINFO (SF) SilverPlatter
PSYMNDEXplus Lit AV (OvidSP) OvidsP
PSYMDEXplus Tests (OvidSP) QvidsP
Public Library Catalog (Ww) Wilsonweb
Public Library Catalog Arch (Ww) WilsonWeb
PubMed (NLM) WLM
Purcell PL Library Catalogs 3
Mserdim 11 [ ST bt e P
w Find by »
— 4 | ess Info: Cancel ] [ Choose ]
File Name: PubMed (MLM).enz
Created: Wednesday, May 14, 2008, 4:52:16 PM
Modified: Monday, May 05, 2008, 12:46:34FM
Based On:
Category: NLM
Comments: |This is an HTTP-based connection file for the
Mational Library of Medicine's PubMed
B v
Showing 2799 of 2799 connection files.

NOTE: This window displays all of the connection files available in your
Connections folder. Use the Find by button to quickly view various
categories of databases to help you locate the one that you need. Or,
type text into the Quick Search text box and press Enter.

2. Select the PubMed connection file (you can start typing the
file name to quickly jump to it in the list), and click Choose.

By selecting that connection file, you have directed EndNote to
connect to the National Library of Medicine’s PubMed database.
If for any reason the connection cannot be established, EndNote
alerts you with an error message and closes the connection.
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When the connection has been established, EndNote displays a
Search tab. Note that the search tab is titled, “Online Search -
PubMed MEDLINE at PubMed (NLM).” The PubMed MEDLINE
database is selected and EndNote is ready to search.

Preview | Online Search - PubMed MEDLINE at PubMed (NLM)

Author (Smith, A.B.) + | | Contains L | E] =
And ¥ | | Year | | Contains hd | E]
And v | | Title + | | Contains hd | E]j
Search Remote Library b

NOTE: If you previously set a default configuration for the Search tab,
the search field lists display the fields you selected as your defaults. If
one of these fields appears italicized in the Search tab lists, that
indicates it is not a valid option for this particular online database.

Search the
Database

The next step is to enter the search term(s) to find the references
you need. Searching an online database is very similar to
searching an EndNote library, with a few exceptions.

Let’s say you are interested in finding more information about
fossils for the sample library.

To enter the search term(s) and perform the search:

1. Set the field list for the first line to Keywords (MeSH), and
enter “fossil” into the search text field. The comparison list
for online searches is always set to Contains.

search term

field list comparison list

logical
operator
lists

Preview | Online Search - PubMed MEDLINE at PubMed (NLM)

Keywords (MeSH) + | | Contains e |fOSSi| E]
And v | |Year | | Contains v | E]
And % | | Title | | Contains v | E]
[ Search ] [ Options.... ¥ ] Search Remote Library A

N
Match Case and Match Words are not available for online searches

2. Click Search.
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EndNote sends the search request off to the online database
(PubMed MEDLINE, in this example), and a summary of the
search results is displayed:

=

Confirm Online Search

Found 4304 records.

Retrieve records from: i through 4304

Mote: Retrieved records are added directly to your EndMote Library.

[ OK ] [ Cancel ]

The dialog displays the number of references that were
found to match your search request, and gives you the
option to retrieve them.

NOTE: PubMed is updated regularly, so you may find a different
number of references than illustrated here.

If the result set seems too big, you can always refine the
search to get closer to exactly those references you want.
Let’s refine this search by looking for just those references
that include mention of a “trilobite,” a group of extinct
marine animals that were abundant in the Paleozoic era.

Click Cancel, and you are returned to the Search tab.

Set the operator at the beginning of the second search line to
And.

5. In the second search line, select Any Field from the field list
and type “trilobite” as the search text.

Preview | Online Search - PubMed MEDLINE at PubMed (MLM)
Keywords (MeSH) + | | Contains A |fOSSi| E]
And %] | Any Field | | Contains | [trilobite ]
And v | | Title + | | Contains v | E]
Search ] [ Options... ¥ ] Search Remote Library v

6. Click Search.
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[#] Sample_Library.enl

This time only 14 references were found.

=

Confirm Online Search

Retrieve records from:

Found 14 records.

B through |14

Mote: Retrieved records are added directly to your EndMote Library.

l

O

] [ Cancel ]

7. For our purposes, limit the download even further. Change
the number in the second box to “10” to limit our download
to the first 10 records.

8. Click OK to retrieve and save the matching references.

The references are downloaded into your library and appear
both in the All References group and in a temporary group
for the PubMed database connection.

You can halt a retrieval in progress by clicking the Cancel
button on the Search tab. Records that have been processed
up to that point already exist in the library.

Groups =

All References (221)
Trash (0)
= Custom Groups
Excavation (8)
Fossils (10}
Literature (10}
- Smart Groups
Eocene (3)
=~ Online Search
Library of Congre... (0}

LISTA (EBSCO)
PubMed (NLM)
Web of Science (...
mare.__.

=- EndMote Web
configure... v

0 @

B Author Year Tile Journal Ref Type URL Last Updated
Webster 2007 A Cambrian peakin morp... Science Journal Article  hitp:fifw...  4/27/2008
Webber 2007 Quantitatively comparing ... Ewolution Int ... Journal Article  hitp:ifw...  4/27/2008
Krell 2005 Trilobite spines and beetl... Biol Lett Journal Article  hitp:/fw...  4/27/2008
Simpson 2005 Development of the caud... Ewvol Dev Journal Article  hitp:/fw...  4/27/2008
Zhu 2004 Direct evidence for preda... Proc Biol Sci Journal Article  http:fiw...  4/27/2008
Fusco 2004 Exploring developmental ... Am Nat Journal Article  hitp:fiw...  4/27/2008
Fortey 2003 A Devonian trilobite witha ~ Science Journal Article  hitpfw . 4/27/2008
Hughes 2003 Trilobite body patterning a... Bioessays Journal Article  hitp:fifw...  4/27/2008
Sepich 2000 Role of the zebrafish trilo... Genesis Journal Article  hitp:ffw...  4/27/2008
Wagner 2000 Exhaustion of morphologi... Evelution Int ... Journal Article http:fiw...  4/27/2008

< >

Preview | Online Search - PubMed MEDLINE at PubMed (MNLIM) |

‘Keywurds (MesH) v| ‘Cuntains V‘ ‘fOSS” E]
and | [any Fieid v | [ contas v Itrilobite B
I»'—\rld—\'l "ﬂﬂe v| ‘Contains v‘ ‘ E]
|SEar|:h Remote Library L2

Showing 10 of 10 references in Group. {(All References: 221)

4 Hide Tab Pane

The temporary PubMed (NLM) group will reset back to 0

references when you close the library.
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Review the At this point you can peruse the retrieved references to make
References sure you want to keep all of them. You may find that some of the
references are not helpful for your research.

While you could open each reference individually to scan
through the bibliographic data, you can also use the Preview tab.

To quickly look at the new references:
1. Click on a reference in the reference list.

2. In the Tab pane, click on the Preview tab to display a
reference preview.

3. On the toolbar, select the Show All Fields output style from
the output style list.

The Show All Fields style is not bibliographic, but represents
all of the fields in your references. On the Preview tab, you
can scroll through the data in the selected reference.

Delete Once you identify references you do not want, you can delete
Unwanted them.
References To delete references:

1. In the PubMed (NLM) group, select two of the displayed
references by holding down the CTRL key and clicking on the
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individual references. (Use SHIFT+click, or click and drag, to
select a range of references.)

«#l Sample_Library.enl E”E|E|
o QOO ® & 0@ ¥

Groups [~/ 8 Author Year  Title Journal Ref Type URL Last Updated
All References (221) Webster A Cambrian peak in morp... Science Journal Article 4/27/2008

Webber Quantitatively comparing ... Evolution Int ... Journal Article 4/27/2008

Trash @ Knell 2005 Trilobite spines and beetl. Bial Lett Journal Article  http/iw. 4/27/2008
Simpson 2005 Development of the caud...  Evol Dev Journal Article  http/iw._.  4/27/2008

= Custom Groups Zhu 2004 Direct evidence for preda_.  Proc Biol Sci  Journal Article http:/iiw . 4/27/2008
Excavation ©) Fusco 2004 Exploring developmental ...  Am Nat Journal Article  httpz/iw...  4/27/2008

. Fortey 2003 A Devonian trilobite with a_.. Science Journal Article  httpz/iw...  4/27/2008

Fossils (10) Hughes 2003 Trilobite body patterning a... Bioessays Journal Article http/fw__.  4/27/2008
Literature (10) Sepich 2000 Role of the zebrafish trilo...  Genesis Journal Article  httpz/iw...  4/27/2008

Wagner 2000 Exhaustion of morphologi... Evolution Int ... Journal Article http:iiw...  4/27/2008
= Smart Groups

Eocene (3
< | B
=- Online Search Preview | Online Search - PubMed MEDLINE at PubMed (NLM)
Library of Congre..  (0) Reference Type: Journal Article s
LISTA (EBSCO) ( Record Number: 346
Author: A J. Webber and B. R. Hunda )
PubMed (NLM) (10) Year: 2007
Web of Science (... (0) Title: Quantitatively comparing morphological trends to environment in the fossil record (Cincinnatian
mare... series; Upper Ordovician)
' |||Journal: Evolution Int J Org Evolution
Volume: 61
=- EndNote Web lesue: &
configure.. o LT sacc oc M
IShowing 10 of 10 references in Group. (All References: 221) 2 Hide Tab Pane

2. From the References menu, select Move References to Trash. The
selected references are removed from the library and put in
the Trash group.

While the references are officially no longer in your library
(they will not appear in any other group or reference list,
they are not included in your reference count, and they
cannot be cited), they are not completely deleted until you go
to the Groups menu and choose Empty Trash. Until you
choose Empty Trash, you can still drag references from the
Trash group back to your active library.

3. Because you are sure that you want to delete the references,
click on the Trash group and then go to the References menu
to select Empty Trash.

4. Confirm the deletion by clicking OK.

Click the All References group to return to the full reference
list, and on the toolbar, set your output style back to
Numbered.

If you wanted to do another search of PubMed at this point, you
could display the PubMed group, enter another search strategy,
and click Search again. On the Confirm Online Search dialog, you
are asked, “Clear currently displayed results before retrieving
records?” This check box simply removes the previous
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downloaded references from the PubMed group; they still exist
in the library. It is an easy way to see just those references
downloaded with the current search strategy.

This concludes the tutorial for using EndNote’s Online Search
command.

If you are finished working with EndNote for now, go to the File
menu and choose Exit to close the EndNote program.

Related See these sections in the full EndNote.PDF manual for
Sections in the information related to this portion of the tour:

Full Manual ¢ See Chapter 6 for details about establishing connections,
searching for references, and retrieving references.

¢ Read “Selecting a Connection File” in Chapter 6 to learn
about the connection files that are available with EndNote.

¢ See “Troubleshooting Connections” in the Troubleshooting
appendix if you encountered any problems establishing a
connection.

¢ See Chapter 18, “Connection Files” for information about
creating and editing connection files.
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